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Creating an animated production

This self-training guide will show you how to set up an animated production using CTP.
It complements the information in the User’s guide, describing all the steps in which you use CTP
during the production process.

Starting a new scene

When you start up CTP, a dialog box appears that lets you create new scenes or open existing
scenes:

» To open an existing scene, select Open existing scene, select a scene from the list, then press
OK.

» To create a new scene, select Create a new scene then enter a scene name in the text box at
the bottom of the dialog box. Now press OK.
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Importing artwork

There are three ways in which you can import images and drawings into CTP: using a scanner,
using video capture, or by importing computer-generated images.

Using a scanner

The Import image from scanner button opens the scanner input dialog. You can also access the
input dialog by clicking on the Insert menu and selecting the Image from scanner option. This
command lets you import images using scanners that apply to the TWAIN standard.

Setting up the scanner

This is a list of options that appear in the Scanner tab in the Import image from scanner dialog:

» Source: Displays the scanner type. If you are running CTP for the first time, press the Select
File button (the one that contains three dots “...“). Now choose your scanner type from the list that
appears. Press the Preview button and scan the first image in your sequence of drawings. This
image will serve as a guide for you to make further adjustments to the scanner settings.

+ Page size: Defines the maximum scanning area. You can increase the viewable area by
clicking the lower-right corner of the dialog box and dragging to resize it.

* Resolution: This feature optimizes the resolution of the scanned image, depending on how
much you plan to zoom into the image with the camera. Enter a field size that corresponds to the
maximum zoom (in fields) that you think you will need to perform on your image. The optimum
resolution for the scanned image is set automatically, depending on the field number you enter.
This feature ensures that the lines on your scanned image will not become aliased (i.e. look like a
bunch of little squares) and remain smooth, even on a tight zoom.

Note: the smaller the field size you set, the greater the resolution of the scanned image, and
therefore the greater the file size for each scanned image.

Tip: the disk-space indicator on the taskbar will tell you if you have adequate disk space available
to store high-resolution images.

» Automatic feeder: Select this option if your scanner is equipped with an automatic sheet feeder
attachment.

« Multiple pages: In conjunction with the automatic feeder option, select this option to scan
multiple pages sequentially.
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Selecting the destination layer in the storage sheet

Select the Sheet tab in the Import image from scanner dialog. The following options appear:

* Frame resolution: shows the current scene’s frame resolution. To change the resolution, select
the Scanner tab, and enter a new field value in the Resolution box (see Resolution in Setting up
the scanner above).

* Cell Code: lets you enter the code of the first image manually. Remember that the code number
for each successive image to be scanned will be increased incrementally from whatever number
you assign to the first scanned image.

* Image layer: selects the storage sheet layer in which you want to store the imported images.

» Shadow layer: selects the storage sheet layer in which you want to store the shadow images.
This option is available only if the Shadow Lines option in the Image tab has been selected.

Choosing the type of art to be scanned

In the Import image from scanner dialog, select the Image tab. You can select from a series of
options depending on what kind of artwork you want to capture:

Capturing pencil drawings

Select the Line image option to import black and white line art images.

Capturing shadow images
Select the Shadow lines option to input shadow lines. This process will detect bright color lines
(red, green, blue, etc.) on your drawings, and separate them from the dark pencil lines to mark

the shadow areas. When the image is scanned, two sets of images will be placed in the storage
sheet: one that contains the line art and another with the corresponding shadow line.

Capturing color overlays

Select the Transparent color option to scan color overlays. It will treat all the white areas on a
color image as transparent areas, letting the other layers in the background show through.

Capturing color backgrounds

Select the Color image option to import color images like painted backgrounds. This option is
usually the default option.
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Adjusting the filters

These are the filter options (Note: These filters can only be applied to line drawings):
* None: No filter is applied, and the image is scanned in exactly at the scanner’s default settings.

* Artistic: This filter will apply basic modifications to the highlights and shadows of an image, but
will respect any type of artistic application to the lines in your drawing. In other words, choose the
Artistic filter if you are using a calligraphic drawing style, or are drawing with lines of varying
thickness, or any time you want to preserve the artistic integrity of the line in your drawing.

» Camera: This filter works wonders on low-contrast images (usually those obtained through
camera input, but can also be used with a scanner). This is the recommended filter for camera
line-test grabbing.

» Scanner: This filter is intended for images obtained from a high-resolution input source (usually
from a scanner).

» Opaque lines: This option, only available with the scanner filter, will guarantee that the line is
always totally opaque at its center. This means that no matter how thin the line becomes, it will
remain solid, so that when you are painting the image later, the color won't spill into other areas.

» Shadows: Modifies the darkness of the lines on the image.
* Highlights: Modifies the whiteness of the areas surrounding the lines.

« Sensitivity: Adjusts the threshold that distinguishes the lines from the background (the contrast
between the dark lines and the white areas).

» Softness: Applies a soft blur to the lines to help avoid rough edges.
Scanner Dialog Utilities

There are ten buttons inside the scanner input dialog that help you to preview and input your
artwork:

Show Real Size

Displays images in the display area at their actual size (pixel accurate).

Fit to window

Adjusts the image size to fit the display area of the dialog box.

© Crater Software 1999-2012
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Show transparency

When you click on this button, all the pure white areas on the image you are scanning are
displayed in red. Wherever you see red, those areas are considered to be transparent by the CTP
software. It is these transparent areas that will be painted in later.

The red areas provide a visual reference, letting you see exactly which areas of your drawing are
truly white, and which ones are gray or off-white. Any part of your drawing that is not pure white
will be considered as part of a line or as an opaque area by the software.

The image transparency button is very useful in conjunction with the filter options, because it lets
you see the contrast between the lines and the white areas on the drawing very easily. You can
then use the filters to adjust the thickness, softness, and opacity of the lines, while simultaneously
making sure that the “fill” areas of your drawing remain pristine.

Move image selection

After you preview the first image to be scanned, press this button to adjust the dimensions of the
scanning area, which is defined by the red rectangle in the display area. Select the corners or the
lines of the red rectangle and drag them to the optimum size to surround the area representing
your drawing.

Show Field Chart

When you press the Show Field Chart button, a field chart is displayed over the previewed image
in the display area of the Scanner input dialog. You can drag the field guide over any part of the
display area. The field chart lets you register images that are scanned individually. In other words,
if you are not using automatic peg detection (see below) the center of the field chart represents
the center of the scanned image.

Pegs

This button lets you access the peg bar detection tools, which are used to help CTP register your
drawings precisely.

Lock peg bar

This button locks and unlocks the peg bar placement you have chosen using the Horizontal pegs
and Vertical pegs buttons (see below).

© Crater Software 1999-2012
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Horizontal pegs and Vertical pegs buttons

When you activate the Automatic peg detection function in the Image tab of the scanner input
dialog, the peg holes are detected by CTP and are used to register the sequence of scanned
drawings. When you preview the first scanned image, press the Pegs button to display an outline
of an ACME peg bar in the viewing area.

* Press Horizontal pegs if the peg holes on your drawing are oriented horizontally on the
scanner’s flat glass bed.

* Press Vertical pegs if the peg holes on your drawing are oriented vertically on the scanner’s flat
glass bed.

You can then drag the outline of the peg bar over the preview image’s peg holes. This will allow
CTP to narrow the search for thee peg holes to a specific area on the scanned images that will
follow, speeding up the scanning process and ensuring that all the drawings are registered

properly.

Note: If you cannot access the Horizontal pegs or Vertical pegs functions, press the Lock peg bar
button to activate the controls.

Performing the scan

Click on the Scan button. The image is placed into the storage sheet layer you specified earlier. If
you are using a scanner equipped with an auto-feed attachment, the images will be scanned one
at a time, then placed sequentially into  the storage sheet layer.

Using video capture

The Import image from video button lets you capture images using a video camera and transfers
them into the storage sheet. When you click on the Import image from video button, the video
input dialog appears. You can also access the input dialog by clicking on the Insert menu and
dragging down to the Image from video input option.

Selecting the destination layer in the storage sheet
Select the Sheet tab in the Import image from video dialog. The following options appear:

* Frame resolution: shows the current scene’s frame resolution. To change the resolution, press
the format button in the Capture Driver tab. The video format dialog appears where you can
change the image dimensions.

* Cell Code: lets you enter the code of the first image manually. Remember that the code number
for each successive image to be scanned will be increased incrementally from whatever number
you assign to the first scanned image.

* Image layer: selects the storage sheet layer in which you want to store the imported images.

» Shadow layer: selects the storage sheet layer in which you want to store the shadow images.
This option is available only if the Shadow Lines option in the Image tab has been selected.

Establishing the capture settings
In the Import image from video dialog, select the Image tab. You can select from a series of
options depending on what kind of artwork you want to capture:
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Capturing pencil drawings

Select the Line image option to import black and white line art images. If this option is grayed out
(i.e. the software won't let you select it), then click on the Adjust filters button in the Import image
from video dialog.

Capturing shadow images

Select the Shadow lines option to input shadow lines. This process will detect bright color lines
(red, green, blue, etc.) on your drawings, and separate them from the dark pencil lines to mark
the shadow areas. When the image is scanned, two sets of images will be placed in the storage
sheet: one that contains the line art and another with the corresponding shadow line.

Capturing color overlays

You can then drag the outline of the peg bar over the preview image’s peg holes. This will allow
CTP to narrow the search for thee peg holes to a specific area on the scanned images that will
follow, speeding up the scanning process and ensuring that all the drawings are registered

properly.

Note: If you cannot access the Horizontal pegs or Vertical pegs functions, press the Lock peg bar
button to activate the controls.

Performing the scan

Click on the Scan button. The image is placed into the storage sheet layer you specified earlier. If
you are using a scanner equipped with an auto-feed attachment, the images will be scanned one
at a time, then placed sequentially into the storage sheet layer.

Using video capture

The Import image from video button lets you capture images using a video camera and transfers
them into the storage sheet. When you click on the Import image from video button, the video
input dialog appears. You can also access the input dialog by clicking on the Insert menu and
dragging down to the Image from video input option.

Selecting the destination layer in the storage sheet
Select the Sheet tab in the Import image from video dialog. The following options appear:

* Frame resolution: shows the current scene’s frame resolution. To change the resolution, press
the format button in the Capture Driver tab. The video format dialog appears where you can
change the image dimensions.

* Cell Code: lets you enter the code of the first image manually. Remember that the code number
for each successive image to be scanned will be increased incrementally from whatever number
you assign to the first scanned image.

* Image layer: selects the storage sheet layer in which you want to store the imported images.

» Shadow layer: selects the storage sheet layer in which you want to store the shadow images.
This option is available only if the Shadow Lines option in the Image tab has been selected.

Establishing the capture settings

In the Import image from video dialog, select the Image tab. You can select from a series of
options depending on what kind of artwork you want to capture:

Capturing pencil drawings

Select the Line image option to import black and white line art images. If this option is grayed out
(i.e. the software won't let you select it), then click on the Adjust filters button in the Import image
from video dialog.
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Capturing shadow images

Select the Shadow lines option to input shadow lines. This process will detect bright color lines
(red, green, blue, etc.) on your drawings, and separate them from the dark pencil lines to mark
the shadow areas. When the image is scanned, two sets of images will be placed in the storage
sheet: one that contains the line art and another with the corresponding shadow line.

Capturing color overlays

Select the Transparent color option to input color overlays. It will treat all the white areas on a
color image as transparent areas, letting the other layers in the background show through.

Capturing color backgrounds

Select the Color image option to input color images like painted backgrounds. This option is
usually the default option.

Adjusting the filters

To adjust the filters, click on the Adjust filters button in the Import image from video dialog. These
are the filter options (Note: These filters can only be applied to line drawings):

* None: No filter is applied, and the image is scanned in exactly at the scanner’s default settings.

« Artistic: This filter will apply basic modifications to the highlights and shadows of an image, but
will respect any type of artistic application to the lines in your drawing. In other words, choose the
Artistic filter if you are using a calligraphic drawing style, or are drawing with lines of varying
thickness, or any time you want to preserve the artistic integrity of the line in your drawing.

« Camera: This filter works wonders on low-contrast images (usually those obtained through
camera input, but can also be used with a scanner). This is the recommended filter for camera
line-test grabbing.

» Scanner: This filter is intended for images obtained from a high-resolution input source (usually
from a scanner, but can also be used with video input).

* Opaque lines: This option, only available with the scanner filter, will guarantee that the line is
always totally opaque at its center. This means that no matter how thin the line becomes, it will
remain solid, so that when you are painting the image later, the color won’t spill into other areas.

» Shadows: Modifies the darkness of the lines on the image.
* Highlights: Modifies the whiteness of the areas surrounding the lines.

* Sensitivity: Adjusts the threshold that distinguishes the lines from the background (the contrast
between the dark lines and the white areas).

+ Softness: Applies a soft blur to the lines to help avoid rough edges.
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Video Input Dialog Utilities

There are ten buttons inside the video input dialog that help you preview your artwork:
Show Real Size

Displays images in the display area at their actual size (pixel accurate).

Fit to window

Adjusts the image size to fit the display area of the dialog box.

Show transparency

When you click on this button, all the pure white areas on the image you are capturing are
displayed in red. Wherever you see red, those areas are considered to be transparent by the CTP
software. It is these transparent areas that will be painted in later.

The red areas provide a visual reference, letting you see exactly which areas of your drawing are
truly white, and which ones are gray or off-white. Any part of your drawing that is not pure white
will be considered as part of a line or as an opaque area by the software.

The image transparency button is very useful in conjunction with the filter options, because it lets
you see the contrast between the lines and the white areas on the drawing very easily. You can
then use the filters to adjust the thickness, softness, and opacity of the lines, while simultaneously
making sure that the “fill” areas of your drawing remain pristine.

Move image selection

Press this button to adjust the dimensions of the scanning area, which is defined by the red
rectangle in the display area. Select the corners or the lines of the red rectangle and drag them to
the optimum size to surround the area representing your drawing.

Show Field Chart

When you press the Show Field Chart button, a field chart is displayed over the previewed image
in the display area of the Scanner input dialog. You can drag the field guide over any part of the
display area.

Important: When capturing an image from video, the center of the field chart represents the
center of the captured image. You should always set the field guide in place over the previewed
image to make sure it is centered properly once the image has been captured.

Pegs, Lock peg bar, Horizontal pegs and Vertical pegs buttons

These buttons let you access the peg bar detection tools, which function best with a scanner.
For more information on the peg bar detection tools, see page 7.

Performing the video capture

Click on the Snapshot button. The image is placed into the storage sheet layer you specified in
the Sheet tab of the video input dialog.
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Importing computer-generated artwork

Selecting the image files

The Import image from file button opens the file input dialog. You can also access the input dialog
by clicking on the Insert menu and dragging down to the Image from file option. The following
options appear:

* Folder: Indicates the folder (directory) where the files to be imported are located. To find files in
a different location, press the “... button. A file browser opens, letting you navigate through your
file system until you find the files you are looking for.

* Name: Indicates the name of the files to be imported. Type in the # sign (press the Shift key
then the number 3 on your keyboard) to indicate what part of the files’ names the sequence
numbers should appear.

* First: The sequence number of the first file to be imported.
* Last: The sequence number of the last file to be imported.

« Step: The step value of the frames to be imported. Use this option if the sequence numbers of
the images you want to import are not consecutive (002, 004, 006, etc.).

* Current: Use this option to preview any file within the range of selected files.

» Sequence: Activate this option if you want to import an entire sequence of images, or deactivate
it if you want to import just one image.

Selecting the destination layer in the storage sheet
Select the Sheet tab in the Import image from video dialog. The following options appear:

* Frame resolution: Shows the current scene’s frame resolution. To change the resolution, press
the format button in the Capture Driver tab. The video format dialog appears where you can
change the image dimensions.

» Cell Code: Lets you enter the code of the first image manually. Remember that the code
number for each successive image to be captured will be increased incrementally from whatever
number you assign to the first captured image.

* Image layer: Lets you select the storage sheet layer where you want to store the imported
images.

» Shadow layer: Lets you select the storage sheet layer in which you want to store the shadow
images. This option is available only if the Shadow Lines option in the Image tab has been
selected.

» Sound layer: If you are importing a QuickTime movie or an AVI movie that contains audio, the
sound layer option appears, which layer lets you select the storage sheet layer in which you want
to store the sounds from the movie. CTP automatically converts the movie files into individual
frames, letting you place the images into an image layer, and the sounds into a sound layer in the
storage sheet.
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Adjusting the filters
To adjust the filters, click on the Adjust filters button in the Import image from video dialog. These
are the filter options (Note: These filters can only be applied to line drawings):

* None: No filter is applied, and the image is scanned in exactly at the scanner’s default settings.

« Artistic: This filter will apply basic modifications to the highlights and shadows of an image, but
will respect any type of artistic application to the lines in your drawing. In other words, choose the
Artistic filter if you are using a calligraphic drawing style, or are drawing with lines of varying
thickness, or any time you want to preserve the artistic integrity of the line in your drawing.

+ Camera: This filter works wonders on low-contrast images (usually those obtained through
camera input, but can also be used with a scanner). This is the recommended filter for camera
line-test grabbing.

» Scanner: This filter is intended for images obtained from a high-resolution input source (usually
from a scanner, but can also be used with video input).

* Opaque lines: This option, only available with the scanner filter, will guarantee that the line is
always totally opaque at its center. This means that no matter how thin the line becomes, it will
remain solid, so that when you are painting the image later, the color won’t spill into other areas.

» Shadows: Modifies the darkness of the lines on the image.
* Highlights: Modifies the whiteness of the areas surrounding the lines.

« Sensitivity: Adjusts the threshold that distinguishes the lines from the background (the contrast
between the dark lines and the white areas).

* Softness: Applies a soft blur to the lines to smooth out rough edges.
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Working on images
Storage sheet

The Storage sheet is where CTP warehouses all the original artwork and sounds that you
captured or imported:

» Very few operations can be carried out in the storage sheet because we want to keep the
original material intact. If you select material in the storage sheet, the only operation you can
perform is to delete (erase) the data to discard obsolete material.

* If you add new artwork or sounds to any storage sheet layers that already contain material, the
new artwork or sounds will always be placed after the existing material.

» There are two types of storage sheet layers: image and audio. The cells in the image layers
have an orange tint, and the cells in the audio layers have a blue tint.

Moving images from the storage sheet to the exposure sheet

To actually perform any work on the material you placed in the storage sheet (such as inking and
painting, creating camera moves, etc.) you must drag the raw material from the storage sheet and
drop it into the exposure sheet.

1. Select groups of cells, entire layers, or individual frames in the storage sheet:
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To select a cell, simply click on it. To select a group of cells, click and drag the cursor over a
range of cells. To select an entire layer, click on the rectangle at the top of the layer. The selected
cells are darkened, and a little rectangle appears next to the arrow cursor, indicating that your
selection has been made.
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2. Click on your selection again, then drag it over a layer in the exposure sheet:
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3. When you let go of the selection, it is placed in the exposure sheet:
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Note: You can also copy the material in the storage sheet and paste it into the exposure sheet if
you prefer, using the copy and paste commands in the edit menu.

Important: when dragging data from one sheet to another, the type of data in the storage sheet
must match the type of data in the exposure sheet layer. In other words, you can’t place a
sequence of line drawings into an audio layer, for example.
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Sheet Settings

To activate the delete and drag & drop options, go to the Tools menu, and select Options. Now
click on the Sheet Settings tab in the dialog box that appears. The following options are available:

Generall Player SheetSettings |Reference| Paintingl

On Delete cells Drag and Drop
: " Insert cell(s)
® Feplace cellis)

» Delete contents: Activate this option if,when deleting cells selected from the exposure sheet,
you want the sheet to remain exactly the way it was and the deleted cells replaced by empty
cells.

* Remove: Activate this option if you want the deleted cells to be replaced by successive cells of
the same layer. All cells below will be moved upwards to fill in the empty spaces.

* Insert: Activate this option if, when dragging a group of cells over another, you want to insert it
where the cursor is located, moving the current one so as to fit the new ones in.

* Replace: Activate this option if, when dragging a group of cells over another, you want the new
ones to replace the current ones.

Note: The insert and replace options can be interchanged by pressing the Shift key while
dragging the cells.
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Exposure sheet

The exposure sheet area resembles a traditional director's exposure sheet. Here are the basic
characteristics of the exposure sheet:

» The exposure sheet always has an Active frame, a frame or a cell that is highlighted in yellow.
The contents of the active frame are displayed in the viewing area, so that you can perform
operations on them (i.e. paint a character, add a camera movement, etc.):
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| 7 0007 A 10044
& 00084,
g ' 10054,
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" 1006,
12
13 10074
14 '
15 ' 10084
16 '
17 ' 10094,
18
19| 10104

Note: If the active selection is a frame of audio, a neutral image (purely decorative) will appear in
the viewing area.

* When you select multiple frames or entire layers in the exposure sheet, the first frame is the
active one, and all the subsequent frames are darkened:
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» There are three types of exposure sheet layers: image, audio, and camera animation.
Image layers have an orange tint, audio layers have a blue tint, and camera animation layers
have a green tint.

» The camera animation layer will affect all the active image layers on its left side, up until the next
camera animation layer, which will affect all the active layers on its left, and so on.
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Activating and de-activating layers
Each image, sound, and camera layer can be made Active or Inactive. When you preview or
output a scene in CTP, only the active layers are processed. This means that you can preview
individual layers one at a time or groups of layers, or all of your layers.

Activate the layer by clicking on the check box at the top of the layer. De-activate the layer by
clicking on the checked box at the top of the layer again.
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» The top of an active layer is displayed in bright yellow with a check mark in the check box. The
top of an inactive layer is displayed in gray, with an empty check box.

Setting repetitions
1. Select a range of cells in a layer, then click on the triangle to the right of the Repeat selected
cells button, and drag down to the repetition number you want. You can also type a number
directly in the number field next to the triangle.
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2. Press the Repeat selected cells button, or hit the Enter key on your keyboard. The cell
code numbers in the repeated cells are displayed in gray:

%l BF -
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0o02e
Q0o03e

o044

0ooae

0006

3. Important: You can also set repetitions by selecting a frame in the exposure sheet and
pressing the “+“ key on the keypad of you keyboard to add repetitions after the frame, and the “—
“key to remove repetitions after the frame.
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Performing a line test

1. Activate the layer or layers you want to test by clicking on the check box at the top of the layer.
If you want to perform the test on a single layer, deactivate any other layers. If you want to
perform the test on multiple layers, activate the appropriate layers.
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2. If you only want to play back a portion of the animation, select a range of cells. It doesn’t matter
if you select cells in other layers, because only the active layers will be played back. If you want
to play back all of the contents of the active layers, you don’t need to select the cells — proceed
to step 3.

! mlE@| w1 | QmE
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B TR

The active layers will be played back in sequence. If you have selected a specific range of cells,
all the selected frames in all the active layers will be played back.
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Reference Layers and Reference Frames (Onion Skinning)

To activate the Onion Skinning or the Reference Layers features, click on the Reference button
above the viewing controls:
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2. To change the Onion Skinning and Reference Layers options, go to the Tools menu and select
Options. Now click on the Reference tab in the dialog box that appears:

Options g|
Eeneral] Flayer ] Drag and Drop  Reference ] F'ainting]

* Reference Layers
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3. The Reference tab contains the following controls:

* Reference layers: When you activate this option, whenever you select the Reference button in
the View controls, all the images in all the active layers for that particular frame number are
displayed. For example, let's say you have an image in layer A and another next to it in layer B,
and both layers are active. If you activate Reference layers, and you select frame 15 in layer A,
the image at frame 15 in layer B will also be displayed.

» Lower opacity: The images in the previous layers (the cells in the layers to the left of the
selected layer’s cell) can be displayed as semi-transparent. You adjust the opacity (transparency)
using the slider or by typing a percentage value in the box on the right.

» Upper opacity: The images in the subsequent layers (the cells in the layers to the right of the
selected layer’s cell) can be displayed as semi-transparent. You adjust the opacity (transparency)
using the slider or by typing a percentage value in the box on the right.

* Reference frames: This is the Onion Skinning feature. When you activate this option, whenever
you select the Reference button in the View controls, the images in the frames before and after
the selected cell are displayed.

* Number of frames: Specifies the number of previous and subsequent frames in a layer that are
displayed when the Reference Frames feature is activated.

* Previous opacity: The images in the cells that precede the selected cell (the cells above the
selected cell) can be displayed as semi-transparent. You adjust the opacity (transparency) using
the slider or by typing a percentage value in the box on the right.

» Next opacity: The images in the cells that follow the selected cell (the cells below the selected
cell) can be displayed as semi-transparent. You adjust the opacity (transparency) using the slider
or by typing a percentage value in the box on the right.
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Inking and painting

Using the ink and paint tools

Selector

Use this tool to select any color, either from the display area or from the color model archive area
(for more information on color model archives, see page 23). The color is inserted in the current
color box, and becomes the active color that is used by the Fill, Paintbrush, Airbrush, and Line
tools.

Fill
The fill tool lets you change the color of any line art, or fill closed areas in a drawing.

» To change the color of line art, you should be in line mode, and click on any part of the line art.
The color change will be extended to all the lines that are interconnected.

« If you click on a line while pressing the Shift key, the color change will be carried out on all the
lines throughout the entire drawing. It doesn’t matter where on the drawing you click; the color will
be applied to the entire cell. If you are satisfied with the color change, press the ok! button. If you
have selected multiple cells, the color change will be extended to all the selected cells.

* To fill a drawing, you should be in Show line & color mode. Click on a closed area (that is, a
part of the drawing that is completely enclosed by lines) and the color will fill the entire area. If
you click on an area that is already filled, the old color will be replaced by the current color you
are using.

* You can also adjust the sensitivity of the fill (i.e. how thoroughly the paint fills the closed area).
To change the fill sensitivity, go to the Tools menu, and select Options. Now click on the
Painting options tab in the dialog box that appears. In the Fill Color section, there is a check box
labeled Sensitive by default. If this check box is active, then the fill tool will automatically try to
fill in the area as thoroughly as possible, even between lines that are very close together. You
can toggle between sensitive fill and standard fill at any time by pressing the Shift button while
clicking on the part of the drawing you want to paint.

» The box fill feature is used to fill several closed areas at the same time. To perform a box fill,
select the fill tool, press the Ctrl key and drag the cursor over the artwork.

Eraser
This tool lets you erase painted areas or lines.

* If you are in Show line & color mode, keep in mind that only the painted areas of the images
will be erased, not the line art.

* If you are in Show line mode, only the line art will be erased.

* When you are in Show line & color mode, you can erase all the painted areas of the cell by
pressing the Shift button on your keyboard and clicking the eraser anywhere in the viewing area.
If you have selected multiple cells, the color erase will be extended to all the selected cells once

you press the ok/ button.
* When you are in Show line mode, you can erase all the line art in the cell by pressing the Shift

button on your keyboard and clicking the eraser anywhere in the viewing area. If you have
selected multiple cells, the line erase will be extended to all the selected cells once you press the

ok! button.
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Paintbrush
Selects the paintbrush tool. You can adjust the following parameters:

* Size: To adjust the size of the paintbrush, click on the brush size button and drag up or down in
the brush parameters’ viewing area.

* Smoothness: To adjust the sharpness or blur around the edges of the brush, click on the
smoothness button and drag up or down in the brush parameters’ viewing area.

» Opacity: To adjust the transparency of the color, click on the opacity button and drag up or
down in the brush parameters’ viewing area.

Airbrush
Selects the airbrush tool.

» The airbrush uses the same formats as the paintbrush (size, smoothness, and opacity) but
applies the paint in a pressure-sensitive manner just like a real airbrush.

« If you are in Show line mode, you can use the airbrush to selectively change the color of the
lines.

Line

Selects the line-drawing tool. The line tool uses the same formats as the paintbrush (size,
smoothness, and opacity) to determine the kind of line that will be drawn. To draw a line, click at
the starting point and drag in the direction you want the line to be drawn.

Drag image

This feature is used in conjunction with the Compose cells button to create composite images
(that is, two images that are placed together to create one larger image). This is useful for
stitching together two or more background images to create one large background. To use the
Compose cells and Drag image commands, do the following:

1. Drag the two images you want to stitch together from the storage sheet into the exposure
sheet.

2. Select one of the cells.
3. Press the Compose cells button.

4. Select the other cell. The Drag image button is activated automatically, and the second image
is superimposed over the first image. The second image appears semi-transparent.

5. Click on the semi-transparent image and drag it to align roughly with the first image.
6. Use the arrow keys to align the pixels of the two images exactly.
7. Press the ok! button. The two images are now combined into one seamless image.

Note: If you are scanning a large background in several parts, because it is too large to be
scanned in one

pass, always make each image overlap with the other a little bit. It makes it easier to align the
pixels later.
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Brush Size

To adjust the size of the paintbrush, click on the width button and drag up or down in the brush
parameters’ viewing area.

Brush Smoothness

To adjust the sharpness or blur around the edges of the brush, click on the blur button and drag
up or down in the brush parameters’ viewing area.

Brush Opacity

To adjust the transparency of the color, click on the opacity button and drag up or down in the
brush parameters’ viewing area.

Current Color and Previous Color boxes
* The upper color box displays the current color that will be applied by the paint tools.

» The lower color box displays the previously selected color. Clicking on the lower box will swap
the contents of the previous color with the current color.

User palette
The user palette stores a series of colors that you can define.

» To select any one of the colors, simply click on one of the boxes in the palette. The contents of
the current color box will change to match the color you just selected.

» To change the color of any of the boxes in the user palette, first select the color box to be
changed, then use the color selector to choose the color you want (see Color Selector below).
The new color appears in the current color box. Now double-click on the current color box. The
contents of the palette box will change to match the current color.

» Whenever you use the same set of colors repeatedly, it can be a bit tiresome to return to the
palette and select new colors. To speed up the color selection process, you can set up the palette
to use the keyboard to shuffle through the colors you use the most:

1. Click on a color box while pressing the Shift key to select colors individually. The selected
color boxes contain a check mark.

2. To select a row of adjacent color boxes, click on the leftmost color box while pressing the Shift
key, then drag towards the right until you reach the last color box in the row. Each color box in the
row will contain a check mark.

3. Once you have selected the colors, use the Q and W keys to cycle between the color boxes.
The Q key will select the colors from right to left, and the W key will select the colors from left to
right.

4. To de-select any of the color boxes, click on the color box while pressing the Shift key.
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Painting with color model archives (reference images)

Creating a color model archive

1. To create a new color model archive (or CMA for short) go to the File menu and scroll down to
New CMA. A blank area will appear under the exposure sheet.

2. Select any imported color image or colored frame from the exposure sheet or the storage sheet

3. Drag the color image or colored frame into the column on the left-hand side of the color model
archive area. You can drag as many images into the archive area as you like.

4. Select a cell in the exposure sheet that you want to paint.

5. Select the fill tool (the little bucket), and drag it over the color model archive. Notice that the
little bucket icon turns into the eyedropper-shaped color selector.

6. Click on any colored area on the color model archive. The color is matched and placed into the
current color box above the user palette.

7. Press the Save CMA button to save the changes you make to your color model archive.
Importing a color model archive (reference image)

1. Press the Open color model archive button, and select an existing color models archive using
the browser. A reference image appears under the exposure sheet.

2. Select a cell in the exposure sheet that you want to paint.

3. Select the fill tool (the little bucket), and drag it over the color model archive. Notice that the
little bucket icon turns into the eyedropper-shaped color selector.

4. Click on any colored area on the color model archive. The color is matched and placed in the
current color area above the user palette.

Replacing colors on an entire painted layer
The Color Replace button lets you substitute colors on a selected range of cells:

1. In the exposure sheet, select a range of cells on a layer you painted already. Make sure you
are in Show Line + Color viewing mode.

2. Using the color selector (the little eyedropper-shaped tool), select the color on the painted cell
that you want to replace. The color will appear in the current color box.

3. Select the new color you want to substitute for the old color from the palette or from a color
model archive. This new color is now set as the current color, and the first color you selected from
your original painted cell appears in the previous color box.

4. Press the color replace button. The color in the current color box is applied to the cell,
replacing the original color throughout the cell.

5. If you are happy with the color substitution, press the 0k! button. A dialog box will appear
asking you if you want to perform the color substitution on all the selected cells. Select Yes.
Wherever the original color appears on all the selected cells, it is substituted for the new color.
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Animating with camera moves

Once you have input your images, colored them, and set their timing, you can add camera
moves. Camera moves in CTP are similar to the controls on a traditional animation camera stand,
letting you recreate the equivalent of peg bar moves and rotations, and camera zooms.

Understanding the concept of camera keyframes

In computer animation, the concept of a camera keyframe is somewhat different from the
definition of a traditional animation keyframe (or key, or key drawing). Traditionally, “keys” are
drawings that represent extreme positions of a character's movement, and “in-between” drawings
are made to fill in the transition frames between each keyframe.

In CTP, a camera keyframe represents the extreme position (pan, zoom, or rotation) of a layer on
a “virtual” camera stand at a given frame number.

A traditional camera operator must take a picture at every frame, each time either sliding or
rotating the peg bars that the layers are attached to, or zooming the camera into or away from the
artwork on a frame-by- frame basis.

In CTP, you only have to set the value of the pan, zoom, or rotation at the frame numbers where
the camera movement is at its most extreme. The computer then calculates the position of the
camera between the camera keyframes automatically.

So, instead of having to set up the camera at each frame, you only set up the camera at the
beginning and at the end of the camera move — the computer does the rest. The use of camera
keyframes speeds up production times immensely when compared to the traditional camera
stand method.

Adding a camera animation layer

To add a camera layer to the exposure sheet, do the following:
1. Activate the image layer by clicking on the check box at the top of the layer.
2. Select the entire image layer by clicking on the top part of the column next to the check box.

3. Click on the Insert camera layer button. A camera layer appears. The animation you apply to
the camera layer will affect all the active image layers to the left of the camera layer, until another
active camera layer is detected.

4. Activate the camera layer by clicking on the check box at the top of the layer.

5. Select a cell in the active camera layer. The animation controls appear.
6. There are four camera parameter buttons that can be animated in CTP:
. X Pan: Sets a value for a horizontal camera pan.

. Y Pan: Sets a value for a vertical camera pan.

. Zoom: Sets a zoom value for the camera.

. Rotate: Sets a rotation value for the camera.
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Animating the camera

Once you have selected the animation parameter for the camera, there are three ways in which
you can animate that parameter:

Interactively animating the camera
1. Select a cell in an active camera layer.
2. Select an animation parameter button (X Pan, Y Pan, Zoom, or Rotate).

3. Click and drag on the image or images in the viewing area. This is what happens, depending
on what animation parameter you selected:

* If you selected X Pan or Y Pan, the image will change positions on the screen. Wherever you
stop dragging the image, a camera keyframe is set automatically, and the letter K appears in the
cell of the camera layer.

« If you selected Zoom or Rotate, as you drag the cursor up and down, the image will be zoomed
or rotated back and forth. Whenever you stop dragging the image, it will stop zooming or rotating,
and a camera keyframe is set. The letter K appears in the cell of the camera layer.

4. Select another cell farther down the camera layer. Repeat step 3, but apply a different value to
the animation parameter. For example, if you are animating a horizontal pan using the X Pan
parameter, place the image in a different part of the screen.

5. In the exposure sheet layer, select the range of frames between the two camera keyframes,
and click the Play Forward button. The animation will be played back.

6. You can keep manipulating the image directly for each parameter at any particular keyframe
until you are satisfied with the results.

Entering numeric values

1. Select a cell in an active camera layer.

2. Select an animation parameter (X Pan, Y Pan, Zoom, or Rotate).

3. Enter a number in the field to the right of the animation parameter you selected.

4. Click on the ok! button. A keyframe is set automatically, and the letter K appears in the cell of
the animation layer.

5. Select another cell farther down the camera layer. Enter a different number in the field to the
right of the animation.

6. Select the range of frames between the two keyframes, and click the Play Forward button.
The animation will be played back.

7. You can keep changing the values for each parameter at a particular keyframe until you are
satisfied with the results.
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Using and interpreting function curves
A function curve is a mathematical representation of the change in an animation parameter over
time. Don’t let this concept discourage you if you are mathematically disinclined — Editing
function curves is a very simple, graphical process, letting you create elaborate camera moves
very quickly and precisely.

How to interpret function curves

In CTP, there are four kinds of camera parameters that generate function curves: X Pan, Y Pan,
Zoom, and Rotate.

* The vertical axis represents the change in value of the parameter.
* The horizontal axis represents time, as measured in frames.

* The slope of the line (its shape) determines the rate of change of a parameter’s value over time.
Therefore, by changing the shape of the curve, you change the animation on the camera layer.

For example, let’'s say we want to create a simple camera pan on a layer containing only one
image of an automobile. Assume that the director wants us to animate an automobile driving from
left to right across the screen. If we select a cell in the camera layer in the exposure sheet, the
function curves appear. If the line is shaped like this...
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the flat line means that the car doesn’t move. The camera is stuck at one position, and it stays at
that position over time, so the automobile looks like it is standing still.

If the line is angled like this...
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« . the straight line means that the camera pan moves at a constant rate. From the first keyframe
to the second keyframe, the camera panned 10 fields over 60 frames, at a constant speed. So
our little automobile appears to move across the screen by ten fields in about two seconds,
without speeding up or slowing down.
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If the line is curved, however, the rate of change is no longer constant — the steeper the slope of
the line, the faster the rate of change, and the shallower the slope of the line, the slower the rate
of change. For example, if the line is curved like this...
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it means that the automobile appears to start off at a fast speed, slow down over time, then stop.
This is because the slope of the line is reduced gradually until finally it flattens out completely. In
the same way, if the line is curved like this...
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it means that the automobile appears to start off slowly and gradually speed up. Now, if the line is
curved like this...
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* it means that the automobile appears to start off slowly, pick up speed, slow down, and then
stop. This curve represents what is traditionally called an “ease-in, ease-out” camera move.
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If the line is curved like this...
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it means that the automobile appears to start off slowly, pick up speed, slow down, stop, start off
again, pick up speed, slow down, and stop a second time.

See if you can guess what would happen to our little automobile if the function curve of the
camera pan were shaped like this:
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When the line curves back downwards, the value of the parameter that is being animated (the
pan, zoom, or rotation of the camera) returns closer to the value at the start of the curve. So in
the case of our camera pan on the little automobile, according to the curve it would appear to
start off slowly, pick up speed, slow down, then stop. But this time, as the curve slopes back
downwards, the car appears to start moving backwards. The car picks up speed driving in
reverse, then finally slows down and stops at its original position.

The example of the camera pan on our little automobile can be applied just as easily to a camera
zoom, or a rotation. The slope of the curve dictates the rate of change of the camera movement,
whether it is a pan, zoom, or rotation. Therefore, If you change the shape of the curve, you
change the rate of the camera animation.

Note: There are certain types of curve that are impossible to create. For example, you would
never get function curves that look like this:
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The reason that these curves are impossible to produce is because time is a constant value,
always moving in one direction. Curves shaped like these would imply that the value of the
animated parameter loops backwards in time. While cartoon characters themselves can violate
the space-time continuum whenever they like, unfortunately, computers aren’t as flexible!

Editing the curves

Editing the slope of the function curve is a matter of dragging the tension points at each
keyframe. The tension points look like little handles on each keyframe that run off from the
function curve at a tangent:

Here are some shortcuts to help you edit function curves:

» Space bar: Press the space bar over the function curves viewing area and drag to pan along
the viewable area of the function curves. If you right-click at the same time as you press the
space bar, then drag the cursor in the viewing area, you can zoom in and out of the function
curves viewing area.

« Ctrl key: To add keyframes directly to the curve, hold the Ctrl key and click on the curve. You
can use this same method to remove unwanted keyframes directly from the curve.

« Shift key: To move keyframes in time from one frame to another, press the Shift key and drag
the keyframe to the desired position. If you wish to level a keyframe’s tension points horizontally,
press the Shift key and drag one of the tension points.
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Creating special effects in CTP

Composing large backgrounds

Sometimes a background image needs to be very large, especially if the director wants to create
a wide panning shot. If a background painting is too large to be scanned in one pass, you can
scan the image in two or more sections, then compose (or stitch together) each section of the
background into one large image.

The Compose cells and Drag image commands are useful for stitching together two or more
background images to create one large background. To use the Compose cells and Drag image
commands, do the following:

1. Drag the two images you want to stitch together from the storage sheet into the exposure
sheet.

2. Select one of the cells.
3. Press the Compose cells button.

4. Select the other cell. The Drag image button in the paint tools is activated automatically, and
the second image is superimposed over the first image. The second image appears semi-
transparent.

5. Click on the semi-transparent image and drag it to align roughly with the first image.
6. Use the arrow keys to align the pixels of the two images exactly.
7. Press the ok! button. The two images are now combined into one seamless image.

Note: If you are scanning a large background in several parts, always make sure each image
overlaps with the other a little bit. It makes it easier to align the pixels later, so you won’t have any
gaps or abrupt seams in the final composited image.
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Finishing touches

Performing an animation test

Activate the layer or layers you want to test by clicking on the check box at the top of the layer. If
you want to perform the test on a single layer, deactivate any other layers. If you want to perform
the test on multiple layers, activate the appropriate layers.
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2. If you only want to play back a portion of the animation, select a range of cells. It doesn’t matter
if you select cells in other layers, because only the active layers will be played back. If you want
to play back all of the contents of the active layers, you don’t need to select the cells — proceed
to step 3.

3. Press the Play Forward button in the view area controls:
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The active layers will be played back in sequence. If you have selected a specific range of cells,
all the selected frames in all the active layers will be played back.
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Outputting to video

I. Activate the layer or layers you want to output by clicking on the check box at the top of the
layer:

IFov I cov|a

0001 A 1001 &
00024, i
00034, 10024
00048, i
0005, 10034,
O006A,
0007 & 10044,
000gs {10044
10054,

3. Press the Video Output button underneath the viewing controls:
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2. Press the Play Forward button:
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3. A dialog box appears, letting you generate a video according to the parameters of your video
output card.
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Outputting to the computer

1. Activate the layer or layers you want to output by clicking on the check box at the top of the
layer.

2. Go to the File menu and scroll down to Export Frames.

3. A dialog box appears, letting you save a sequence of composited images anywhere on your
computer’s file system.

Managing your animated productions

Saving and backing up your work

To save a scene, go to the File menu and scroll down to Save As. A browser appears, which lets
you save the scene in the default CTP Scenes folder, or anywhere else on your computer’s file
system.

Remember that the CTP scene file is really like a directory (or folder) containing the parts of each
animated production (the images, sounds, camera animations, etc.). When you want to back up
the scene file to a storage medium (removable drive, tape backup, etc.) remember that the
contents of the scene file are as important as the scene file itself Back up the contents of the
Scenes folder early and often, just to be safe.
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